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Section 1

Project X Concepts
PROJECT X CONCEPTS

What is Project X

1. What is Project X

Simply put, Project X is the next generation of UltraESB. It consists of all the API

2. Message Formats

definitions, core implementations of those APIs, messaging engine, message

3. Message Context
4. Transports

format definitions and implementations, metrics engine etc. These core
functionalities and capabilities provided by project x can be enriched by using it in
combination with transports, connectors and processing elements. These sub

5. Connectors

components makes the usage of UltraESB more user intuitive and user friendly

6. Processors

than the previous versions.

Message Formats
Message formats are the various kinds of message payloads supported and
handled by project-x. As of now, the following types of Message Formats are
supported.
★ ByteArray Format
This format can be used to keep the payload of the message as an array of bytes.
The number of bytes in the array is considered as the size of the payload.
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★ Empty Format
This format can be used to create a message without an actual
payload. This will be useful in situations where the payload of the

underlying object cannot be guaranteed, this format does not
support API methods such as reading payload as a stream or
retrieving size of the payload.

message is not yet available at the time of the message creation.

★ StringFormat

★ File Format

This format can be used to have a Java String as the payload.

This format can be used to have a regular operating system file as
the payload of the message. The length of the file in bytes is

The length of the String object is considered as the size of the
payload.

considered as the size of this type of payload.

Message Context

★ Map Format

Message Context is a wrapper object that includes an actual
message object inside. Each message context has a unique

This message format keeps a Java Map as the payload. The size

identifier and contains all the contextual properties related to the

of the map i.e. the number of key-value mappings is considered

processing of the message such as transactional information,

as the size of this type of payload. Along with the common API

resource handlers, scope information, context properties and also

methods implementations, this message format provides

provides means to manipulate contextual data such as scope

methods to access the properties of the underlying map.

variables.

★ Message File Format

In a simple integration flow which does not clone or split the

This format is also similar to the FileFormat but it contains the
payload in a XMessageFile i.e. an entry in UltraESB File Store
rather than in a regular operating system file.

message, the same message context is being used throughout
the flow. Even in a request-response scenario, the same message
context will be used in both request path and response path,
though the request message and response message are diﬀerent.

★ Object Format
This format can be used to have any Java Object as the payload
of the message. Since the actual behavior or the properties if the
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Transports

Connectors

Transports implement the low level communication

Connectors represent the high level communication

protocols supported by the ESB to communicate with other ESB

methodologies supported by the ESB. There are mainly two types

instances or outside systems. Currently the ESB supports the

of connectors as Ingress Connectors and Egress Connectors.

following transport protocols and many more.

An ingress connector uses a specific transport listener

★ HTTP (Netty/NIO)

implementation to receive messages, while an egress connector

★ JMS

uses a specific transport sender to send messages out.

★ File Polling

These ingress connectors and egress connectors can be

★ File NIO

further divided into 2 categories as one-directional and bi-

★ SFTP

directional. One-directional ingress connectors only accept

★ FIX
★ AMQP

messages from an outside system while bi-directional ingress
connectors accept messages and also send back a response for
the received message. Similarly, one-directional egress

★ SCP

connectors only send messages to an outside system while bi-

★ Timer

directional egress connectors send messages out and also
receive a response for the sent message.

Almost all of these transport implementations consist of a listener

The following connectors and many more are currently supported

implementation as well as a sender implementation. Transport

by the ESB.

listeners are used to receive messages to the ESB and transport
senders are used to send messages out of the ESB. While one or

★ HTTP (Netty/NIO) Ingress and Egress

more ingress connectors can depend on a single transport

★ JMS Ingress and Egress

listener, one or more egress connectors can depend on a single

★ AS2 Ingress and Egress

transport sender.

★ File Polling Ingress and Egress
★ File NIO Ingress
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★ SFTP Ingress and Egress

One of the outports of a processing elements is always an “On

★ FIX Ingress and Egress

Error” outport, to which the message context is directed in case

★ AMQP Ingress and Egress

of an error occurred while processing.

★ IBM-MQ Egress

Currently the ESB supports several processing elements under

★ SCP Ingress and Egress

the categories such as,

★ Timer Ingress

★ Header management

Any Integration Flow in UltraESB-X must be started with an

★ Scope management

ingress connector element.

Processors
Processors (Processing Elements) are used to process a

★ Scope variable manipulation
★ Payload transformation
★ Payload validation

message inside an integration flow. Each processing element

★ Payload extraction

accepts a message context, performs a specific processing on it

★ Attachment processing

and emits one or more message contexts depending on the type

★ Logging and auditing

of processing.
Depending on the type, each processing element has one or
more outports. These outports also has 2 diﬀerent types as
single-outports and multiple-outports. A single-outports can be
connected only to a single processing element/connector while a
multiple-outport can be connected to more than one processing
elements/connectors.
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Section 2

Installing UltraStudio
INSTALLING ULTRASTUDIO

This section describes how to install UltraStudio within IntelliJ IDEA and set it up

1. Integrating UltraStudio with IntelliJ IDEA

properly.
If you have already downloaded the IntelliJ IDEA community edition where the
UltraStudio is pre-built in, you can skip this section. On the other hand if you have
downloaded only the UltraStudio plugin, follow this section to install it properly on
IntelliJ IDEA.
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Integrating UltraStudio with IntelliJ IDEA
Prerequisite:

Open IntelliJ IDEA settings window (Files -> Settings) and
under plugins section, click on “Install Plugin from disk...” button.
Next select the “UltraStudio-17.07.zip” file and click on open

★ Oracle JDK 1.8

button (figure a). After that UltraStudio will be integrated with

★ Maven 3.3.x

IntelliJ IDEA and you will need to restart IDEA to take eﬀect.

★ IntelliJ IDEA Community/Ultimate Edition 2017.1 or newer
version

Figure a: Installing UltraStudio
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Section 3

Project Creation
PROJECT CREATION
1. Creating a new empty project with
component dependencies
2. Creating a new sample project from the
Sample repository

Within Ultra Studio, there are mainly two ways to create a new project. You
can create a new project with only the required component dependencies and
keep on building the integration flows you want.
Otherwise, if you are completely new to the Ultra Studio, the best way to
start exploring UltraStudio is through a sample project. In the sample project
repository, there are various types of sample projects and you can select one and
create a project which includes the sample integration flows in that project. Once,
you create a sample project, you can directly run it and send messages through it
without any configuration.
Now let us see how we can create a project in each approach mentioned above in
details.
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Creating an Empty Project

Figure 3.1: New Project
In-order to create an empty project go to File menu and
select New Project. Next select Empty Ultra Project and
continue. After that, as shown in the figure 3.1, you will be
presented with a wizard to enter the project details. Keep in mind
that this new project will be a maven project and hence, you have
to specify the maven specific properties such as Group ID, and

Next, you have to specify the release artifact URL. This URL
must point to the remote maven repository where the UltraESB
release artifacts can be obtained. Similarly, the SNAPSHOT URL
represent the remote maven repository where the SNAPSHOT
artifacts of the UltraESB can be obtained.

Version. The base package represent the base package name for
your custom Java classes and UltraESB version is the specific
version of the ESB which should be used with this project.

NOTE: It is highly discouraged to use SNAPSHOT artifacts in
production environment since they are highly brittle. You must always
use release artifacts which are stable, in production environment
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Figure 3.2: Connector Component List
After Clicking next button, you will be presented with the
connector component list. This list contains various connectors
which provide the facility to handle various transports such as
HTTP/S, JMS, SFTP, etc. You can select connectors you want for
your project from this list and that connector will be automatically
added to you project as a dependency.

which you can use in your integration flows to manipulate
messages which are flowing through the UltraESB.
After selecting which components you want to be added to
your project, you will be presented with the final step of the
project creation wizard. In this step, you have to specify the name
of your project and the location on your file system where this

In the next step of the wizard, you will be presented with a list of

should be created. With that you are done with creating a new

processors which can be added to your project as dependencies.

empty project and click on the finish button to continue.

This processor list contains various types of processing elements
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Creating a Sample Project

Figure 3.3: Sample Repository
In-order to create a sample project, select Sample Ultra Project

If you are new to UltraStudio, you should start with an

from the new project creation wizard. Next as shown in Figure 1,

Introductory sample to get an idea about the whole concept.

specify the project specific details and proceed by clicking the
next button.
Then the sample repository will be loaded and you can directly

After selecting the sample, it will be automatically downloaded
and click on the next button and specify the location on your file
system where the project should be created.

download the sample you want by clicking on the download
button ( Figure 3.3 ) or you can read more about the sample by
clicking on the view button.
Mainly there are three types of samples in the Sample Repository
and those are ‘Introductory’, ‘Intermediary’ and ‘Advanced’.
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Section 4

Overview of Project Structure
OVERVIEW OF PROJECT STRUCTURE
1. Project Structure

In this chapter the basic component of an Ultra Project and the main

• Project.xpml File

components of the UltraStudio integration flow development environment will be

• Conf Directory

discussed.

2. Main Components of the Editor View
• Main Toolbar
• Component Pallet
• Properties Pane
• Design Canvas
• Components

12

After creating an Empty Ultra Project as described in the

Further, within the main directory, there is a directory named conf

previous section, the overall project structure will look as Figure

and this is where all your integration flows should reside. Apart

4.1. In the maven Projects tab, all the dependencies specified in

from that the project structure is similar to an empty Maven

the pom.xml file will be shown as well.

Project.

Figure 4.1: Project
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Project Structure
Now let’s see what are the new components in the Ultra
Project.

will be added. When you run the project, only the integration
flows specified in this section will be deployed
Apart from that within the resources tag, you can specify re-

Project.xpml File
This file contains the information about your project such as

usable complex spring beans which in return used by
components in your integration flow. We will look into in details in
What is project.xpml section.

name, version and description.
<x:project id="mySampleProject" name="mySampleProject"
version="1.0-SNAPSHOT"
xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:x="http://www.adroitlogic.org/x/x-project"
xsi:schemaLocation="http://www.adroitlogic.org/x/x-project
http://schemas.adroitlogic.org/x/x-project-1.0.0.xsd
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-4.1.
xsd">
<x:description>
A sample project that demonstrates the projects concept
</x:description>

Conf Directory
This is where all your integration flows must reside. It is not
recommended to create integration flows anywhere else in the
project. Although, you can create sub-directories within conf
directory to organize your flows.
Apart from these main two items, there are few files in the
test/resources directory and for now you do not need to worry
about those.
Now let’s create our first integration flow. Keep in mind that

<x:flows>
<x:flow id="sampleFlow" file="helloWorldFlow.xcml"/>
</x:flows>

all the integration flows which are created must reside within the

<x:resources>
</x:resources>

context menu, select Integration Flow. After that specify

</x:project>

Figure 4.2: Sample project.xpml file

conf directory. First right click on the conf directory and from the
helloWorldFlow as the flow name and click on OK button.
Now you can see that there is a new file added to the conf
directory and double click on it to open it in the editor view.

Further, within the flows tag, all the integration flows in your
project where file path is specified relative to the conf directory
14

Figure 4.3: Design View
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Main Components of the Editor View

2. Component Pallet
This pallet (Figure 4.3:2) contains all the components
required to create an integration flow. There are ingress/egress

1. Main Toolbar

connectors, processors, and so on. If you want to refresh your
memory on what these are, refer to the core-concepts of projectx chapter.
Figure 4.4: Main Toolbar

3. Properties Pane

The main toolbar (Figure 4.3:1) contains all the important

This pane (Figure 4.3:3) contains all the properties

functionalities which aﬀect the design view. Below list contains

which can be specified by the user for a particular

brief description of each button and the respective functionality of

component. i.e. for a given component to function

that button (Figure 4.4).

properly, user has to manually specify some

a. Toggle the Component Pallet’s visibility

properties and these properties varies from one

b. Toggle the Property Pane’s visibility
c. Toggle the visibility of grids on the design canvas
d. Refresh the Design Canvas
e. Highlight the message execution path in the integration flow
f. Scroll to the beginning of the integration flow
g. Zoom in the Design Canvas
h. Zoom out the Design Canvas
i. Reset the Zoom view of Design Canvas

component to another. Apart from that, this pane
contains a Documentation tabs which provides the
basic documentation of the specific component.
Further, the property pane contains few functionalities to
manipulate the component properties such as
a. Saving the modified configuration properties of a component
b. Clone the component with the existing configuration properties
c. Reset the configuration properties of the component
d. Delete the component from the design pane
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Apart from that, in the property pane for each property, there is a
slider at the right side of the property pane. If you hover over it, a
tooltip with the message
Externalize Property as : <PropertyName>

will be shown. If the slider is enabled, the actual property value

Figure 4.5: Sample Component

will be written to the src/main/resources/default.properties

✦ In-Port (grey color circle) - This is where messages are given as

file and a placeholder will be added to the integration flow file.

input to the component. A component can have only one in-port

This feature is useful when you want to externalize the property
values when running the project in UltraESB-X container. After

and specific type of components such as ingress connectors
have zero in-ports

building the project, if you want to modify the value of an

✦ Out-Port (green color circle) - This is where the output message

externalized property, you can do it easily without doing any

is emitted from the component. There can be zero or more

modification to the project bundle by modifying the respective

outports for a particular component.

properties file in UltraESB-X container.
✦ Side-ports (blue color circle) - These ports are used to connect
4. Design Canvas
This is where you can create your integration flow. You can

other components as parameters for a particular component.
There can be zero or more side ports for a particular component.

drag and drop component from the component pallet in to the

✦ Exception-Port (red color circle) - This is a sub set of out ports

design pane and keep on creating your flow (Figure 4.3:4).

and an output is emitted from the component through this port if

5. Components

an exception or an error occurs while executing the component’s
logic, so that the user can gracefully handle it.

Each component is unique and designed to execute a
specific logic. As shown in figure 4.5 the circles surrounding the
component icon are called ports. Mainly there are four port types.
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Section 5

Developing an Integration Flow
DEVELOPING AN INTEGRATION FLOW

In this chapter let’s see how we can develop, run and debug a very basic

1. Creating an Integration Flow

Integration Flow in the UltraStudio.

2. Running Flow Validation

In this integration flow, let’s create an Echo HTTP endpoint where when we run the

3. Configuring Component Properties

UltraESB-X with the developed integration flow deployed we expose an HTTP

4. Building and Running the Project
5. Sending Messages and Debugging Flow

resource endpoint so that we can send HTTP requests with any payload and the
response for the HTTP request will be the same as the content of the request
payload.

NOTE: For this project it is required to select HTTP NIO CONNECTOR from the
connector list when creating the project. Refer to Section 3, in-order to refresh your
memory on how to create a project with connectors and processor components.
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Creating an Integration Flow File

After that, we need to connect these two component as shown in

First right click on the src/main/conf directory and from the

HTTP NIO Ingress Connector with the in-port of the HTTP NIO

context menu, select Integration Flow as shown in figure 5.1

Egress Connector and the Response Processor out-port of the

figure 5.2. We have to connect the Processor out port of the

HTTP NIO Egress Connector with the in-port of the HTTP NIO
Ingress Connector.

Figure 5.1: Context Menu
Next, specify HelloWorld as the name of the Integration flow and
create our first Integration flow.
Now Let’s add our components to the
Design Canvas so that we in-order to

Figure 5.2: Connected Integration Flow

complete the flow. First, select the NIO

We have created our first Integration Flow. Now all we have to do

HTTP Ingress Connector from the

is to specify the required component properties.

component pallet and drag-and-drop it into
the design canvas. You will be presented
with a dialog box to specify a name to the
component and let’s specify http-incomponent as the name. Next, drag-anddrop the NIO HTTP Egress Connector to
the design canvas and as for its name, let’s
specify http-out-component.
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Running Flow Validation

As you can see, there are couple of error within our flow. If you

Next, we need to run the Flow Validator to findout if there is any

component.

error in out integration flow. The Flow Validator resides at the
bottom of UltraStudio tool pane as shown in figure 5.3.

double click on a error result, it will navigate you to the erronous

These error are expected since we have not specified the
mandatory proprties of the components on the design canvas. If
we are to run the integration project in current state, it will fail
since the integration flow is incomplete.
As you can see, Flow Validator can be used to makesure the
integration flow you have developed is in correct state and all the
requirements are fullfiled before running the project to avoid
erronous scenarios due to invalid or incomplete configuration.

Figure 5.3: Flow Validation Panel
Click on the green colored run button to start the flow validator
and after the completion of flow validation you will see the result
as shown in figure 5.4

Configuring Component Properties
Now let’s specify the required properties in the each component.
First, click on the NIO HTTP Ingress Connector and there are
mainly two mandatory properties we need to specify under the
Basic Tab (Figure 5.5).
HTTP Port - The port we want our HTTP Ingress Connector to
start listening for incoming request. For this example let’s specify
8280.

Figure 5.4: Flow Validation Result
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Service Path - The resource path where we want to filter out the

Service Path - The remote service path we want to connect.

incoming requests. Specify /service/echo-proxy for that.

Specify /service/EchoService for that

After specifying those properties, click on the save button. Now

After that save the configuration by clicking on the Save Button.

we have configured our HTTP Ingress Connector to listen at
http://localhost:8280/service/echo-proxy for
incoming requests.

Figure 5.5: Property configuration for NIO HTTP Ingress Connector
Similarly, we need to configure our NIO HTTP Egress Connector
as well (Figure 5.6).
Destination Address Type - The type of the destination address.
For this example, select URL.

Figure 5.6: Property configuration for NIO HTTP Egress Connector
Now if you run the flow validator again, you will be able to see
that flow validation has passed successfully.

Destination Host - Host name of the destination endpoint. For
this example, specify localhost.
Destination Port - The remote port we want to connect. Specify
9000 as the value.
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Building and Running the Project

[INFO] -----------------------------------------------------------------------[INFO] BUILD SUCCESS

First let’s compile the project. Note that it is not mandatory to

[INFO] -----------------------------------------------------------------------[INFO] Total time: 1.952 s

compile the project each time you want to run the project (it is

[INFO] Finished at: 2016-10-07T10:47:50+05:30

done automatically before running the project). But for the

[INFO] ------------------------------------------------------------------------

[INFO] Final Memory: 28M/402M

Figure 5.8: Terminal output

moment, let’s see how we can compile and build our project
bundle.

NOTE: When building the project, maven will fetch the

First open the terminal tab and execute mvn clean install

dependencies from the remote repository. Although if those

command as shown in the figure 5.7

dependencies are already cached in the M2 home, maven will use
the dependencies in the local cache instead of downloading them
from the remote repository

Now our project is bundled into a file with the extension .xpr and
if you inspect the target directory within the project you will be
able to see it.
Now we need to create the run configuration. First click on
Run → Edit Configurations…

Figure 5.7: Terminal Tab
After successfully building the project, you will see an output as
shown below on in the terminal.

menu item and open the Run/Debug Configuration window. Next
from the context menu shown after clicking on the + icon select
UltraESB-X server, and specify a name for your configuration
(figure 5.9) and click on OK button.
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When you have downloaded UltraStudio, you got an email which
included a client Id and you need that Id, in-order to activate the
UltraEBS-X server. Copy the clientId from the email and go to File
→ Settings (IntelliJ IDEA → Preference on MacOS) and go to
Tools →Ultra Studio section. In there, under Client Key text box,
paste the client key and save it.
After that, click on the run button again and you will see below
output on run tab which signals that the UltraESB has started
successfully.
INFO XContainer AdroitLogic UltraStudio UltraESB-X
server started successfully in 2 seconds and 524

Figure 5.9: Run/Debug Configuration
After that click on the run button on toolbar (figure 5.10)

milliseconds

NOTE: If you haven’t received a client key or you have misplaced it,
you can obtain a new client key by dropping an email to
license@adroitlogic.com

Figure 5.10: Run Button on Toolbar
Next, you will get a message as below
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Sending Messages and Debugging Flow

(figure 5.12:2) and send it (figure 5.12:3) after changing the URL
into http://localhost:8280/service/echo-proxy

In-order to send a message, first we need to start a backend
echo service on http://localhost:9000/service/EchoService
Fear not, we provide a very basic jetty server for testing and
debugging purposes within the Ultra Studio. As shown in figure
5.11 click on the start button (green play button) to start a Jetty
server on port 9000.

Figure 5.12: HTTP Client Panel

Now in the response window, you can see the response, and the
response payload is as same as the request payload since we
sent the message to an echo server. (Make sure UltraESB-X
server is up and running as described in Building and running the
project section)
One other useful feature of Ultra Studio is that we can view the
message execution path in the flow we have created. Click on the
highlight message execution path icon on main toolbar and it will
Figure 5.11: Embedded Jetty Server Panel

highlight the execution path as shown in figure 5.13.

After that in-order to send a sample message we can use the
HTTP client integrated with the Ultra Studio. As shown in figure
5.12, create a new HTTP client (figure 5.12:1), select payload 1
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Figure 5.13: Highlighted Message Execution Path

This feature comes in handy when there is a complex message
flow and you want to check which branches of the flow got
executed while processing the message.
Further, if you click on the message icon for a particular link,
you can see the full message context which passed through that
particular link as shown in figure 5.14.

Figure 5.14: Message Context View
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Section 6

Writing Custom Processing Elements
In Ultra Studio, you can write your own custom processing

package com.acme.esb;

elements to execute your own logic as well. In this section let’s

import
import
import
import
import

see how we can write a very basic hello world processing
element.
This element will obtain an input, i.e. the user name from the user
as a property and write “Hello ${username}“ to the console.

@Processor(displayName = "", type = ProcessorType.CUSTOM,
description = "")
public class ConsoleLogger extends AbstractProcessingElement {

First within src/main/java directory in the com.acme.esb

@Override
public ExecutionResult process(XMessageContext
messageContext) {
//TODO: execute any end processing logic
return ExecutionResult.SUCCESS;
}

package create a new processing element by right clicking on
the package name, and selecting New → Processing Element.
Specify ConsoleLogger as the Class Name.
After that a Java class will be created as shown in figure 6.1. As
you can see, ConsoleLogger is extended from the
AbstractProcessingElement class. Whenever you write a

custom processing element, you must extend from this class
since it abstract out all the functionalities required by Project-X
framework to use the custom processing element properly.
Further, there is an annotation named Processor associated with
the Processing Element class. This annotation is used to obtain
information about this processing element in the design view.

org.adroitlogic.x.api.ExecutionResult;
org.adroitlogic.x.api.XMessageContext;
org.adroitlogic.x.annotation.config.Processor;
org.adroitlogic.x.api.config.ProcessorType;
org.adroitlogic.x.base.processor.AbstractProcessingElement;

}

Figure 6.1: Processing Element code template
As for the processor annotation, for now we only need to specify
a display name (which will be shown in the component pallet)
and a description.
Further, we need to set the requireConfiguration property to be
true so that when our custom processing element is drag-and
dropped on to the design canvas, the property pane for the
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component will be automatically shown. Below list briefly

be shown only in integration flow file’s component pallet, and

describe each property in the annotation

same goes for SUB_FLOW as well. Default value is ALL i.e. the

✦ type - This represent the subcategory the custom processing

particular component will be shown in all flow files.

element belongs to under the processors category. You can

★ description - A brief description to explain the functionality of

specify any value (GENERIC, TRANSFORMER,

your element. This will be shown under documentation tab in the

FLOW_CONTROLLER, VALIDATOR, CUSTOM, EIP, SCOPE,

property pane

ERROR_HANDLING) under
org.adroitlogic.x.api.config.ProcessorType enum.

★ requireConfiguration - If the value is true, when a user add
this component to the design canvas, the property pane will be

✦ customType - You can specify any value for this and this value

shown automatically and if the value is false, the property

will be used to categorize your processing element when shown

container will not be shown after adding this component to the

in the component pallet.

design pane

✦ displayName - This value is showed in the component pallet to

★ documentationURL - URL of the resource which contains a

represent the processing element along with the icon of the

comprehensive documentation for this processing element. This

element

link will be shown under Documentation tab in the property pane.

✦ iconFileName - Name of the icon file to be assigned with this

For more information on annotation properties, refer the API

custom processing element.

documentation ( https://developer.adroitlogic.org/project-x/api/
17.07/apidocs/org/adroitlogic/x/annotation/config/Processor.html)

NOTE: You need to specify the full URL of the icon file. It MUST be
a resource which is accessible over HTTP/S protocol.

✦ scope - Mainly there are Integration Flows and Sub Flows. You
can specify any value (ALL, NONE, INTEGRATION_FLOW,
SUB_FLOW) from the org.adroitlogic.x.api.config.ScopeType
enum. If you specify INTEGRATION_FLOW, then this element will
27

Now let’s modify the annotation properties of our ConsoleLogger

For a comprehensive documentation on the properties in the

as shown in figure 6.2.

Parameter annotation, refer the API documentation. (https://
developer.adroitlogic.org/project-x/api/17.07/apidocs/org/

@Processor(displayName = "Console Logger",
type = ProcessorType.CUSTOM,
requireConfiguration = true,
description = "Console Logger Processing element
adds a log line to the console")

Figure 6.2: Processor annotation

adroitlogic/x/annotation/config/Parameter.html)
After that we need to configure the logging annotations in-order
to use the logging framework provided by the project-x
framework. The most useful advantage of using this logging
framework is that it will generate a unique code for each and

Now we can move on to writing our custom logic. We need to
write our logic within

every log line and it will easier to pin-point the any issue by
analyzing the log file.

process(XMessageContext messageContext)

First, right click on the com.acme.esb package name directory

method because, when the framework execute the message flow,

Now a package-info file will be added. Next place the cursor one

this method will get executed. Within the process() method, you

line before the package name and right click. Form the context

will get the messageContext as a parameter. If you do not

menu select Generate… and you will be shown the code

remember what message context is, refer core concepts of

generation menu as shown in figure 6.4

and from the context menu, select New → package-info.java.

Proejct-X to refresh your memory.
First of all we need the user’s name as an input for our custom
logic. Hence, we can add a string class variable and annotate it
with Parameter annotation as shown in figure 6.3.
@Parameter(displayName = "User Name",
inputType = InputType.TEXT_BOX,
placeHolder = "Sajith",
description = "Specify the username to be displayed on
the console")
private String username;

Figure 6.3: Parameter annotation

Figure 6.4: Code generation menu
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From that menu, select LogInfo Annotation. After that, you will be

Next, place the cursor inside the process() method and obtain the

asked for a component type and for that specify CTM. Now your

code generation menu as described previously. Now from that

package-info file should look as below

menu select Info Log. You can see that a logger statement is

@LogInfo(componentType = "CTM", moduleId = 0,
nextModuleId = 1, maxModuleId = 1,
nextLoggerId = 1)
package com.acme.esb;
import org.adroitlogic.x.logging.LogInfo;

Next, go to the Console Logger processing element and put the
cursor one line before @Processor annotation and right click.

added to within the process() method and the nextLogCode value
of the @LogInfo annotation has been incremented by one.
The logic in process() method is shown in Figure 6.6.
@Override
public ExecutionResult process(XMessageContext
messageContext) {
logger.info(1, "Hello {}", username);
return ExecutionResult.SUCCESS;
}

From the context menu select Generate… and you will be shown
the code generation menu as shown in figure 6.5

Figure 6.6: Process() method logic

One more thing to note is that after executing our logic, we need
to pass the message to the other processing element in the
message flow. This step is optional. You can write an element
which can be used as the last processing element of the flow as
well. In-order to add a next element, you need to add a
XProcessingElement class variable with Outport annotation as

shown in figure 6.7

Figure 6.5: Code generation menu
From that menu select LogInfo Annotation and a new @LogInfo
annotation will be added to your class as below

@OutPort(displayName = "Next Element",
description = "Success output from the
ConsoleLogger")
private XProcessingElement nextElement;

Figure 6.6: Outport Annotation

@LogInfo(loggerId = 1, nextLogCode = 1)
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The properties you need to modify in the outport annotation are
✦ displayName - The name to be displayed when user hover on
the outport
✦ description - A brief description about under what
circumstance an output will be emitted through this outport. This
description will be shown in the documentation tab on the
property pane
For more information on Outport annotation refer API
documentation (https://developer.adroitlogic.org/project-x/api/

package com.acme.esb;
import
import
import
import
import
import
import
import
import

org.adroitlogic.x.annotation.config.OutPort;
org.adroitlogic.x.annotation.config.Parameter;
org.adroitlogic.x.api.ExecutionResult;
org.adroitlogic.x.api.XMessageContext;
org.adroitlogic.x.annotation.config.Processor;
org.adroitlogic.x.api.config.InputType;
org.adroitlogic.x.api.config.ProcessorType;
org.adroitlogic.x.api.processor.XProcessingElement;
org.adroitlogic.x.base.processor.AbstractProcessingElement;

import org.adroitlogic.x.logging.LogInfo;
@LogInfo(loggerId = 1, nextLogCode = 2)
@Processor(displayName = "Console Logger", type = ProcessorType.CUSTOM,
requireConfiguration = true,
description = "Console Logger Processing element
adds a log line to the console")
public class ConsoleLogger extends AbstractProcessingElement {
@OutPort(displayName = "Next Element",
description = "Success output from the ConsoleLogger")
private XProcessingElement nextElement;

17.07/apidocs/org/adroitlogic/x/annotation/config/OutPort.html)

@Parameter(displayName = "User Name",
inputType = InputType.TEXT_BOX,
placeHolder = "Sajith",
description = "Specify the username to be displayed
on the console")
private String username;

Now we can modify the process method as below.
@Override
public ExecutionResult process(XMessageContext messageContext) {
logger.info(1, "Hello {}", username);
return nextElement.processMessage(messageContext);
}

@Override
public ExecutionResult process(XMessageContext messageContext) {
logger.info(1, "Hello {}", username);
return nextElement.processMessage(messageContext);
}

Figure 6.7 shows the completed class code. Now Let’s compile

public XProcessingElement getNextElement() {
return nextElement;
}

the project via mvn clean install command.

public void setNextElement(XProcessingElement nextElement) {
this.nextElement = nextElement;
}
public String getUsername() {
return username;
}
public void setUsername(String username) {
this.username = username;
}
}

Figure 6.7: Complete code of ConsoleLogger
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After opening our helloWorldFlow (if the flow is already opened,

Specify your name and save the property and modify the flow as

click on the Refresh Current View button on the tool bar), in the

shown in figure 6.8

component pallet, under processors/custom you can see our new
processing element. When you add the new element to the
design pane, you can see that the property pane is automatically
opened and there is a property named User Name.

Now let’s run the project and send a new message. If you inspect
the console log, you can see our custom message is printed with
the user specified property.

Figure 6.8: Integration flow with Console Logger
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Section 7

What is Project.xpml?
WHAT IS PROJECT.XPML?

In this section we will learn about the Project.xpml file and its content. From now

1. Basics of Project.xpml File

on, I will refer to it as XPML file since there can be only one Project.xpml file within

2. How to Add Resources

a single Ultra Project.

3. Writing Custom Resource Templates

Basics of Project.xpml File

4. Adding a Resource From Template

The XPML file is the beginning point of the project when it comes to the execution
of the project. Sample XPML file is shown in Figure 7.1 and there are few key
components in this file
✴ Project Id - This specifies the Id of the project (id="mySampleProject)
✴ Project Name - Name of the current Project (name="mySampleProject")
✴ Project Version - Current version of the project (version="1.0-SNAPSHOT")
✴ Description - A brief description about the current project
✴ Flows - This section contains the current Integration Flows in the project. Only
the flows specified in this section will be deployed when the project is executed.
✴ Resources - This section contains spring beans which are used by the
Integration Flows.
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<x:project id="mySampleProject" name="mySampleProject"
version="1.0-SNAPSHOT"
xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:x="http://www.adroitlogic.org/x/x-project"
xsi:schemaLocation="http://www.adroitlogic.org/x/x-project
http://schemas.adroitlogic.org/x/x-project-1.0.0.xsd
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-4.1.
xsd">
<x:description>
A sample project that demonstrates the projects concept
</x:description>
<x:flows>
<x:flow id="sampleFlow" file="helloWorldFlow.xcml"/>
</x:flows>
<x:resources>
</x:resources>

Map - Type xmap and press tab key and the code template for a
Map will be injected to the XPML file.
List - Type xlist and press tab key and the code template for a
List will be injected to the XPML file.

Writing Custom Resource Templates
Suppose you want to write a custom processing element or a
connector and within that component, a complex set of resources
are used. In this case, the user has to add each resource one by
one into the XPML file. This is an arduous and an unintuitive task.
In-order to overcome this problem, you can write a resource

</x:project>

template.
Figure 7.1: Sample project.xpml file

Suppose if I were to write a JMS ingress and egress connectors
which uses ActiveMQ and in-order to use those connectors,

How to Add Resources

following resources should be present in the XPML file

Under the resources section you can add Spring beans, Maps
and Lists. There are keyboard shortcuts to add the boilerplate
code.
Beans - Type xbean and press tab key and the code template for

<x:resource id="activeMq-ConnectionFactory">
<bean class="org.apache.activemq.ActiveMQConnectionFactory">
<property name="brokerURL" value="tcp://localhost:61616"/>
</bean>
</x:resource>

Spring bean resource will be injected to the XPML file.
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<x:resource id="activeMq-jmxTxnManager">
<bean class=
"org.springframework.jms.connection.JmsTransactionManager">
<constructor-arg
index="0"
type="javax.jms.ConnectionFactory"
ref="activeMq-springCachingConnectionFactory"/>
</bean>
</x:resource>
<x:resource id="activeMq-ultraTxnmanager">
<bean class=
"org.adroitlogic.x.base.trp.UltraPlatformTransactionManager">
<property name="txnManager" ref="activeMq-jmxTxnManager"/>
</bean>
</x:resource>
<x:resource id="activeMq-jmsTemplate">
<bean class="org.springframework.jms.core.JmsTemplate">
<constructor-arg
index="0"
type="javax.jms.ConnectionFactory"
ref="activeMq-springCachingConnectionFactory"/>
</bean>
</x:resource>
<x:resource id="activeMq-springCachingConnectionFactory">
<bean class=
"org.springframework.jms.connection.CachingConnectionFactory">
<constructor-arg index="0"
type="javax.jms.ConnectionFactory"
ref="activeMq-ConnectionFactory"/>
</bean>
</x:resource>

The class MUST implement the XResourceTemplate interface
and override the getXmlConfiguration() method. This method
will be invoked by UltraStudio to obtain the string which should
be appended to the XPML file. Hence, this string MUST return a
complete resource configuration.
If you need user input to build the resource configuration, as we
did with custom processing elements, you can specify the inputs
with Parameter annotation and add setters for the properties.
UltraStudio will scan the class and show a model for the user to
enter the inputs and the parameter annotated properties will be
initialized with the user inputs prior to the invocation of
getXmlConfiguration() method.

It is a MUST to add a parameter with the variable name
beanPrefix. User can add a single resource template with
multiple values to the project.xpml file. In that case all the
resource Ids should be prefixed with the beanPrefix as shown in
figure 7.2 (Complete code is available at https://gist.github.com/
sajithdilshan/b0b4fab55bcc46c8795e9a1b9bcbdafd)

Instead of asking the user to specify all the above resources, you
could provide a template and obtain only the brokerURL from the
user.
Figure 7.2 shows a sample Java class for the resource template.
The ResourceTemplate annotation indicates that this class is a
resource template and it will be picked up by the UltraStudio.
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import
import
import
import

org.adroitlogic.x.annotation.config.Parameter;
org.adroitlogic.x.api.config.InputType;
org.adroitlogic.x.api.template.ResourceTemplate;
org.adroitlogic.x.api.template.XResourceTemplate;

import java.util.UUID;
@ResourceTemplate(displayName = "ActiveMQ JMS")
public class ActiveMQJmsConfiguration implements XResourceTemplate {
@Parameter(displayName = "Resource ID Prefix", description = "Specify the ID prefix
for configuration resources",
inputType = InputType.TEXT_BOX, placeHolder = "MQ1")
private String beanPrefix;
@Parameter(displayName = "Broker URL", description = "Specify the URL of the broker",
inputType = InputType.TEXT_BOX,
placeHolder = "tcp://localhost:61616", propertyName = "brokerURL")
private String brokerURL = "localhost";
@Parameter(displayName = "Username", description = "Specify the username for the
broker", inputType = InputType.TEXT_BOX,
isOptional = true, propertyName = "userName")
private String userName;
@Parameter(displayName = "Password", description = "Specify the password for the
above mentioned user",
inputType = InputType.TEXT_BOX, isOptional = true,
propertyName = "password")
private String password;

"
<constructor-arg index=\"0\"
type=\"javax.jms.ConnectionFactory\" ref=\"BEANPREFIX-activeMQ-springCachingConnectionFactory\"/>\n" +
"
</bean>\n" +
"
</x:resource>\n" +
"
<x:resource id=\"BEANPREFIX-activeMQ-ultraTxnManager\">\n" +
"
<bean
class=\"org.adroitlogic.x.base.trp.UltraPlatformTransactionManager\">\n" +
"
<property name=\"txnManager\" ref=\"BEANPREFIX-activeMQ-jmxTxnManager\"/>\n" +
"
</bean>\n" +
"
</x:resource>\n" +
"
<x:resource id=\"BEANPREFIX-activeMQ-jmsTemplate\">\n" +
"
<bean class=\"org.springframework.jms.core.JmsTemplate\">\n" +
"
<constructor-arg index=\"0\"
type=\"javax.jms.ConnectionFactory\" ref=\"BEANPREFIX-activeMQ-springCachingConnectionFactory\"/>\n" +
"
</bean>\n" +
"
</x:resource>\n" +
"
<x:resource id=\"BEANPREFIX-activeMQ-springCachingConnectionFactory\">\n" +
"
<bean
class=\"org.springframework.jms.connection.CachingConnectionFactory\">\n" +
"
<constructor-arg index=\"0\"
type=\"javax.jms.ConnectionFactory\" ref=\"BEANPREFIX-activeMQ-ConnectionFactory\"/>\n" +
"
</bean>\n" +
"
</x:resource>";
public String getBrokerURL() {
return brokerURL;
}

@Override
public String getXmlConfiguration() {
if (beanPrefix == null) {
beanPrefix = UUID.randomUUID().toString();
}
String newConfig = CONFIG.replaceAll("BEANPREFIX", beanPrefix);

public void setBrokerURL(String brokerURL) {
this.brokerURL = brokerURL;
}
public String getUserName() {
return userName;
}

String auth = "";
if (userName != null) {
auth = String.format(AUTH, userName, password);
}

public void setUserName(String userName) {
this.userName = userName;
}

return String.format(newConfig, brokerURL, auth);
}

public String getPassword() {
return password;
}

private static final String AUTH =
"
<property name=\"userName\" value=\"%s\"/>\n" +
"
<property name=\"password\" value=\"%s\"/>\n";
private static final String CONFIG = "\n" +
"
<x:resource id=\"BEANPREFIX-activeMQ-ConnectionFactory\">\n" +
"
<bean
class=\"org.apache.activemq.ActiveMQConnectionFactory\">\n" +
"
<property name=\"brokerURL\" value=\"%s\"/>\n" +
"%s" +
"
</bean>\n" +
"
</x:resource>\n" +
"
<x:resource id=\"BEANPREFIX-activeMQ-jmxTxnManager\">\n" +
"
<bean
class=\"org.springframework.jms.connection.JmsTransactionManager\">\n" +

public void setPassword(String password) {
this.password = password;
}
public String getBeanPrefix() {
return beanPrefix;
}
public void setBeanPrefix(String beanPrefix) {
this.beanPrefix = beanPrefix;
}
}

Figure 7.2: Custom Resource Template Code
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Adding a Resource From Template
After compiling the configuration template class, open the
project.xpml file. Next right click within the XPML file and from the
context menu select Resource Template.(Figure 7.3)

Figure 7.3: Context Menu

Next from the pop-up window, select the Resource template we
have created (ActiveMQ JMS) and click continue button. Next

Figure 7.4: Active MQ JMS Resource Template

specify the required properties in the modal dialog box (figure 7.4)
and click on the save button to add the resource configuration
into the project.xpml file.
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Section 8

Miscellaneous Features
MISCELLANEOUS FEATURES

In this section we will look at few other components present in UltraStudio and

1. Component Registry

those feature are

2. Password Encryptor

1. Component Registry

3. IPS Uploader

2. Password Encryptor
3. IPS Uploader
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Component Registry
Component Registry can be used to add Processors and
Connectors to the Integration Project after you have created the
project. Component Registry can be opened via Tools →
UltraStudio → Component Registry menu item. After that you will

processors and and click OK button. Next you will be shown the
Component Registry as shown in Figure 8.1.
Note that there are two tabs (Connectors and Processors) in the
Component Registry and from those tabs you can select the
component you want to create your integration flow.

be shown a dialog box with the modules in the current project.
Select the module you want to add new connectors or

Password Encryptor
Password Encryptor can be accessed via Tools → UltraStudio →
Password Encryptor menu item. In the dialog box there are
couple of items you need to specify. These encrypted passwords
can be directly used in your property configurations in integration
flows.
★ Secret - Specify the secret you want to encrypt
★ Algorithm - Specify the algorithm you want to encrypt the
secret. Note that the required Java library which includes the
encryption algorithm mechanism MUST be included as an
dependency in the pom.xml file. The default value for algorithm is
PBEWithMD5AndDES. Further you can specify this algorithm via
X_ADRT_ENC_ALG environment variable/System property as
well

Figure 8.1 Component Registry
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★ Password - The password which is used to encrypt the secret.
You can use X_ADRT_ENC_PWD environment variable/System
property to specify this password as well.
★ Provider - You need to specify the security provider in here.
You can specify this value via X_ADRT_SEC_PVD environment
variable/System property. The default value is
org.bouncycastle.jce.provider.BouncyCastleProvider.

IPS Uploader
AdroitLogic Integration Platform as a Service (IPS) defines a new
and convenient way to easily integrate your systems with
minimum setup time, low maintenance cost and hassle free
configuration updates. This is a stack designed to deploy,
manage and monitor Adroitlogic’s high performance UltraESB-X
instances on a public or private cloud environments.
UltraStudio provided direct integration with IPS and all you have
to do is specify the URL of the hosted IPS instance in the
UltraStudio Preference.
First compile the project and build the .xpr bundle. After that click
Figure 8.2 Password Encryptor

on Tools → UltraStudio → IPS Uploader menu item. Next, select
the Project Artifact and specify the IPS user credentials (Figure
8.3.
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If you want to deploy the project on an existing cluster, select the
Deploy on existing Cluster option. After that you will be shown a
list of existing clusters in the IPS instance (Figure 8.5). Select the
cluster you want to deploy the project and click OK.

Figure 8.5 Cluster Selection
Figure 8.3 Project Uploader

After that you will get a message similar to the below one.

After specifying the above mentioned properties click on OK

Uploaded the project and deployed on cluster. Server

button and project will be uploaded into IPS. After the project is

responded

uploaded to IPS successfully, you will be given the option to

successfully

deploy the project on a existing cluster or on a new cluster (Figure

On the other hand, if you want to deploy the project on a new

8.4)

cluster select Create a new Cluster from figure 8.4. In the new

with:

Cluster

version

deployment

started

cluster creation dialog box specify Cluster Name, select an Image
Id, Node Group as well. Specify the replication count and a
Cluster Type as well. All the other properties are Advanced
options.
Figure 8.4 Project upload message
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Figure 8.5 Create New Cluster
After specifying the above mentioned properties, and clicking on
OK, you will get a message as below upon successful cluster
deployment.
Created the cluster and uploaded the project. Server
responded

with

:

Cluster

version

deployment

started

successfully
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Section 9

UltraStudio Preferences
UltraStudio provides the functionality to modify the UI of Editor pane as well as
various other functionalities. This section elaborates on the Preferences provided
by UltraStudio which can be modified by the end user.
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Figure 9.1: UltraStudio Settings Panel
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✦ Icon Theme
Icon theme to be used for connectors and processors.
✦ IPS URL
UltraStudio provides integration with IPS and you can
directly upload a project you have created in UltraStudio into

✦ Sample Project Repository
Specify the URL of the Sample UltraProject repository.
Default value is https://developer.adroitlogic.org/samples/
17.07.
✦ Remote Dependency Repository

IPS. For this property, you need to specify the URL of the

Specify the URL of the JSON file which contains the

hosted IPS instance.

information of processors and connectors. The default value

✦ UltraESB-X License Key

is https://developer.adroitlogic.com/ultrastudio/json/
17_07.json.

You can start an UltraESB-X instance within UltraStudio and
deploy, test the project you have developed. But in-order to
do that, you need to obtain a license from the AdroitLogic to
perpetually run the UltraESB-X runtime. After obtaining the
license, specify it here. By default, a 30 day evaluation
license is specified.
✦ UltraESB-X Client Key
A Client key is required to activate the license when running
the UltraESB-X instance. The client key is sent to the user
via an email when UltraStudio is downloaded. A new client
k e y c a n b e o b t a i n e d b y d ro p p i n g a n e m a i l t o
license@adroitlogic.com
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Section 10

UltraStudio Toolbox
ULTRASTUDIO TOOLBOX

UltraStudio Comes with a number of utility components which helps the developer

1. HTTP/S Client

to test, debug integration flows. Mainly there are six components which can be

2. Socket Client

used to ease your Integration Flow development tasks and those are

3. JMS Client

1.

HTTP/S Client

4. JMS Receiver/Browser

2.

Socket Client

3.

JMS Client

4.

JMS Receiver/Browser

5.

Jetty Server

6.

TCP Dump Tool

5. Jetty Server
6. TCP Dump Tool
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HTTP/S Client
Features and Capabilities
The HTTP/S client panel provides a full RFC 2616 compliant

✦ Sending SOAP requests with custom SOAPActions
✦ Setting HTTP headers
✦ Unzipping a gzipped response payload for read.

HTTP/S client based on the Apache HttpComponents/HttpClient

✦ Sending a concurrent load specifying the concurrency level and

project. The HTTP/S client panel is capable of

number of iterations

✦ Sending HTTP/S requests with POST, GET, PUT, DELETE,

Configuration Parameters

HEAD, OPTIONS & TRACE methods
✦ Supporting 2-way SSL, ignoring SSL, ignoring host name
verification
✦ Validation and support BASIC, DIGEST or NTLM authentication
✦ Setting preset payloads
✦ Setting payload by typing in or selecting a payload file
✦ Using binary payloads - such as raw Hessian messages
✦ Sending requests using both HTTP 1.0 and 1.1 version

Configuration

URL

A well formed URL which the request should send
to. Once a new URL is entered it will be saved and
can be selected from the drop down menu at the
end of the URL field.

Method

Select one of POST, GET, PUT, DELETE, HEAD,
OPTIONS & TRACE from the drop down menu to
set as the requests HTTP method

Content Type

Select one of the given content type or a user can
enter their own type, which will be set as Http
header "Content-Type" for requests that has a
payload

✦ Controlling the use of chunking, expectation control (i.e. waiting
for a 100 continue reply before sending the body), keep-alive and
response compression control (i.e. accepting Gzipped
responses).
✦ Setting the socket timeout to allow the client to specify the
maximum delay for a response to arrive.

Description
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Request

Request payload to send with the request. This
field becomes not accessible for HTTP methods
that don’t expect a payload (e.g : GET)

Sample
Requests

A user can easily set a one of four preset payloads
to send a test message

Request
Controls

A request payload can be imported from a file,
export to a file and view in full screen

Java Bench
Controls

These input fields configure the load testing
parameters.
1. Concurrency : Number of concurrent threads to
be used when sending requests
2. Iterations : Number of requests send per a
thread
3. Verbosity : Verbosity level of the output

Configuration

Description

Socket Timeout

Amount of time in seconds that the client waits for
a response before time out

Http Version

A user can switch between Http 1.0 and Http 1.1 by
choosing the relevant value

Use Expect

Select whether to use expect-100 header to
indicate the capability to the server

Accept Gzip

Select whether client supports gzip for the
response payload or not

SOAP Action

Set custom soap action if required

Keep Alive

Use Connection keep alive at the clients side

Use Chuncking Use HTTP payload chunking for the client

Response
Controls

A response message can be export to a file and
view in full screen. If gzip compression is enabled,
then only unzip payload checkbox is visible. If
Unzip Checkbox is selected the response payload
field will display the extracted payload.

DEBUG SSL
Engine

Enable SSL level debugging, note that this could
be set only before executing a request for the first
time.

Custom Header Configuration

Advanced Configuration

Header configuration can be added and removed from the table
as header name header value pairs.
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Authentication Configuration

Authentication Configuration consist of two parts; HTTP
Authentication Configuration and SSL Configuration
1. Configuration for HTTP Authentication
User can select one of Basic, Digest and NTLM types and provide
required authentication details.

2. SSL Configuration
Even though the client talks to a HTTPS endpoint, HTTPS client
can disable SSL verification for testing purposes. SSL verification
will only work when Enable SSL Verification check box is
selected. When SSL verification is enabled a user can optionally
select whether to verify the server host name or not by
selecting Enable hostname verification check box. When SSL
verification is enabled, Trust store and Identity store information
should be provided.
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Socket Client
Features and Capabilities
The raw socket allows the user to send valid, invalid, malformed,
corrupted or malicious payloads to the selected host over to the
selected port. This is useful to test the negative test scenarios
which are otherwise diﬃcult to identify, reproduce and fix.

payload must be separated from the header by a blank line as per
the specification.
Configuration
The configuration is rather simple. Hostname and Port should be
the hostname and port number of the server. There are four
preset sample requests available in Sample requests
panel. Request control allows to a user to import requests from

Some service hosting engines and ESBs may not be able to even

a file as well as export the current requests to a file

accept malformed requests, even for logging purposes. Note that

while Response Control allows a user to export the response

this is an advanced option and expects the user to be familiar

from the server to a file.

with the HTTP RFC 2616 for operation. The most common
mistake a novice user usually does is specifying a wrong content
length - which should be the size of the payload in bytes. The

49

JMS Client

Configuration

Description

Features and Capabilities

Destination
Name

Destination queue name that the message should
sent to.

The JMS client panel provides a JMS client utility which can send
JMS messages to ActiveMQ, HornetMQ and IBMMQ JMS

Import and
Export

Import file content to be sent out or export content
in the payload field.

queues. The JMS client panel is capable of

Payload

A user can set either Text Message or Byte
Message as the request payload.

• Sending Text or Byte JMS messages
• Adding diﬀerent type of JMS message headers
• Setting various JMS message properties including Correlation

Connection Configuration

ID, Message ID, Expiration, Time Stamp, Priority etc.
• Importing requests from file locations

Main Configuration

A user can set the type of JMS server from this configuration
panel. For Active MQ and HornetMQ servers hostname of the
server and port number should be provided as the connection
configuration where IBM MQ required two additional
configurations, Channel and Queue Manager.
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For the case of IBM MQ, the IBM MQ client libraries should be
added using the file picker at the right most side of the panel
since there is a license limitation to ship those libraries.

Configuration

Correlation ID

The JMSCorrelationID header field is used for
linking one message with another. It typically links
a reply message with its requesting message

Message ID

The JMSMessageID header field contains a value
that uniquely identifies each message sent by a
provider.

Reply To

Destination to which to send a response to this
message

Expiration

The time the message expires, which is the sum of
the time-to-live value specified by the client and the
GMT at the time of the send

Time Stamp

The JMSTimestamp header field contains the time
a message was handed off to a provider to be
sent. It is not the time the message was actually
transmitted, because the actual send may occur
later due to transactions or other client-side
queueing of messages.

Priority

The JMS API defines ten levels of priority value,
with 0 as the lowest priority and 9 as the highest. In
addition, clients should consider priorities 0-4 as
gradations of normal priority and priorities 5-9 as
gradations of expedited priority

Redelivered

If set Specifies whether this message is being
redelivered. This field is set at the time the
message is delivered.

Delivery mode

If selected sets the DeliveryMode value for this
message as Persistent, else set it as non
persistence

JMS Header Configuration

Header configuration can be added and removed from the table
as header name, header value pairs with the header type. Integer,
Long, Boolean and String type headers can be added.

Description

Advanced Configuration
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JMS Receiver/Browser
Features and Capabilities
The JMS Receiver/Browser panel provides a JMS client utility
which can obtain/browse JMS messages from ActiveMQ,
HornetMQ and IBMMQ JMS queues. The JMS Receiver/Browser
panel is capable of
• Receiving Text or Byte JMS messages
• Showing content of individual messages
The diﬀerence between Receive and Browse modes is that in
Receive mode, the message will be removed from the source
queue once it is fetched by the JMS client panel. In the Browse
mode, the original message will not be removed from the source
queue, and the user can view the content of the message from
the JMS client panel.
The configuration is similar to the JMS Client and once a
message has been obtained/browsed from the queue, you can
view the content of the message by double clicking on it
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Jetty Server
Features and Capabilities
The Jetty server contains an implementation of the
SimpleStockQuoteService (copied with modifications from the
Apache Synapse project). And EchoService which is a high
performance service which will echo back the request received.
Thus it can be used to echo back various message sizes - say
1K, 5K, 10K etc for load and performance testing. Specifying an
Echo service delay, causes the responses to be delayed by the
specified number of milliseconds. This is useful to analyze how an
ESB not using a Non-Blocking IO approach can easily block,
when handling a large number of concurrent connections - which
must be kept open until the delayed responses are received. The
sample service also contains a servlet that will output a plain text
response and an HTML response, to analyze how the UltraESB
can handle these types of responses.
Configuration
The configuration is as simple as it could be, just specify the port
number which the server should run on and hit the start button.
Additionally you can select Echo service delay in Milli
seconds. You can see the started servers in the below Jetty
Servers panel where you can stop/start again or change the delay
as you desired. Controls on your right allows you to stop and
remove servers one by one or all at once.
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Configuration

TCP Dump Tool
Features and Capabilities
The TCP Dump Tool allows
one to easily monitor, and
optionally capture the
messages sent at the wire
level for debugging, or
capturing (e.g. for a
subsequent load test)
purposes. The messages

Configuration

Listen Port

The port number that TCP dump should listen to,
TCP Dump Tool will will start a socket on this port,
thus this port should not be already bound to
another program.

Forward Port

The Forward port number which the back end
server runs

Forward Host

The Forward Hostname which the back end server
runs

Dump Mode

A user can dump either a text format or binary Hex
format

Save File
Location

If the user wants the TCP dump to be saved to a
file in order to analyze it later give the file location
here.

can be captured as Text, or
binary Hex. The Listen port
accepts messages on the
local machine where the
TCP Dump Tool is executed,
and forwards the message to
the Forward Host over
the Forward Port specified.
To save the request being sent, specify a file with the full path in
the Save request to file option

Description
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Section 11

Frequently Asked Questions
Q: Component and Connectors are not shown in Component Pallet
A: Make sure the project is added as a Maven project and all the specified dependencies in the pom.xml file are shown in Maven
Projects tab
Q: pom.xml file is invalid
A: If you are getting an error saying Failed to load the dependencies from the pom.xml file. Make sure Project SDK is specified, then make
sure you have specified a valid Project SDK under project structure (File → Project Structure… )
Q: Message Execution paths are not getting highlighted
A: You need to specify Oracle JDK as the IDEA’s running JDK. In order to do that, press Shift key twice and type Switch IDE boot
JDK and execute that action. Next, from the dialog window, select the Oracle JDK and restart IDEA.
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